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1 Intr oduction

TheprogramRubik allows you to manipulatea virtual 3x3x3Rubik's cube.It runson eithera
Mac(runningOSX, version10.2.4or later)or a PCandprovidesthefollowing features:

� Manipulatethecube(twist faces,slices,andthewholecube,andundoyour twists).

� Jumblethecube.

� Resetthecubeto solved.

� Solvea jumbledcube(whetherit wasjumbledby you or by thecomputer).

� Enter your own cubecon�guration (to �nd a solution for your own physicalcube,for
example).

� De�ne andapplymacros.Macrosaresetsof twistsgroupedtogetherandassignedaname
sothatthesetof movescanbeappliedasa unit.

� Determinetheorderof a macro.Theorderof a macrois thenumberof timesyou needto
repeatthemacrofrom a solvedcubeto returnto asolvedcube.

� Runtheprogramin a mesmerizingdemomode.

TheRubik programis basedin parton thework of theFLTK project(http://www.�tk.or g)—a
darnedgoodpieceof software.

2 BasicCube Manipulation

If the cube tur ns too quickly or too slowly, seethe descriptionof the Speedbutton in the
descriptionof thecommandsin Section12.

To runtheprogram,justdouble-clicktheRubik programicon. Youshouldseeawindow some-
thing like thatin �gure 1 (exceptthat thedisplayedcubewill not bejumbledwhentheprogram
starts).

Two cubesarevisible—thelargeonecanbe manipulatedandthesmalleroneis a view of the
backof thesamecube.Rememberthatit is truly abackview—thebluesideis theright faceand
theorangesideis thebackface.
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Figure1: Rubik Window

To rotatea face90 degreesclockwise(asyou look at that face)click on the centercubie1 on
that facewith the mouse. If you hold the shift key down while you click on a face,it rotates
90degreescounter-clockwise.To obtaina half turn,simply click two timeson theface's center
cubie.

In general,if theshift key is down, the inverseoperationis performed.For example,if a com-
mandrotatestheentirecuberight, that samecommandwith theshift key down will rotatethe
entirecubeto theleft andsoon. This is nicein thatif youscrew upamovement,youcanalmost
alwayshold theshift key down and“repeatyourmistake” to undoit.

If you hold down thecontrol key while you click on thecentercubieof a face,theentirecube
turns90 degreesclockwise. If you hold both thecontrol andshift keys down whenyou click,
theentirecubeis rotatedby 90degreescounter-clockwise.

If youholddown thealt key while youclick onthecentercubieof aface,thecentersliceparallel
to that faceturns90 degreesclockwise.If you hold boththealt andshift keys down whenyou
click, thatsamecentersliceis rotatedby 90degreescounter-clockwise.

Finally if you hold down both thecontrol andalt keys, the faceoppositeis turned90 degrees
from thepointof view of thefaceyouclickedon. For example,if youclick onthefront facewith
thecontrol andalt keys down, thebackfacewill rotateclockwiseasit appearson thescreen.
Remember, however, that if you werelooking directly at thebackface,this would appearto be
a counter-clockwisetwist. As before,theadditionof theshift key reversesthedirectionof the

1Thename“cubie” appliesto any of thesmalleroutercubesthatmakeup theentire3 � 3 � 3 cube.
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turn.

To undomoves,usethe Undo entryin the Edit pull-down menuor typethecontrol-Z shortcut.
Youcanissueundocommandsrepeatedlyandeachundoesonemove. (If you just wantto undo
a singlemove, it' s usuallyeasierjust to repeatwhatever you did threemoretimes(or repeatit
oncewith theshift key down) sincethenyou don't have to move themouseto �nd the Undo
menuentryor reachfor thekeyboardto typecontrol-Z.)

All of theseoperationscanalsobe appliedwith buttonsin the control areato the right of the
window. As before,if theshift key is down, themovementsarereversed.

Finally, thereareshortcutkeys for any of thebasicfacemovements(not thesliceor whole-cube
movements,however). If you hold down thealt key andtype“ f”, “ r ”, “d”, “ l”, “b” or “u” then
the front, right, down, et ceterafaceis turned90 degreesclockwise. If the shift key is down,
thenthatfaceis turnedcounter-clockwise.

3 CubeCoordinatesand MoveDescriptions

Although at �rst glance,it seemslike it might be bestto describeelementsof a cubeby their
colors,this is notagoodideafor two reasons:

1. Differentcubeswith differentmanufacturershave differentarrangementsof thefacecol-
ors.

2. If you've learneda sequenceof moves that, for example,exchangestwo adjacentcor-
ners,this sameoperationcanbe appliedto any pair of adjacentcorners.A color-based
descriptionwouldonly applyto onepair.

If youholdacubein front of youwith onefacetowardtheceilingandlookingdirectlyatanother
face,therearesix facesaltogetherthatwe will call “Up”, “Down”, “Left”, “Right”, “Back” and
“Front”. In the intial cubecon�guration the default facecolorsof Rubik hasthe white face
“Up”, theredface“Front” andthegreenface“Left”. Althoughyou cannotseethemexceptin
therearview, thebluefaceis “Right”, theorangefaceis “Back”, andtheyellow faceis “Down”.

If your cubeis not arrangedlike this, you canresetthecubecolorsso that theprogram's cube
will look likeyourphysicalcube.SeeSection10.

Thesenamesof thefacesarefairly standard,andthey areabbreviatedby their �rst letterswhich
areluckily all different:B F U D L R. Theothergreatthingaboutthenamesis thatthelettersin
theorderabovealmostspell“befuddler”of which thecubesurelyis one.

To helpavoid errors,theFront,Left andUp facesarelabeledwith the letters“F”, “L” and“U”
on thecomputerdisplay.

Thebuttonsin thecontrolareareferto thesecoordinates.For example,thebuttonlabeledDcw
meansto turn theDown face90 degreesclockwise.That's clockwisewhenyou arelooking at
the middle of the Down face. Similarly, Bccw meansturn the backface90 degreescounter-
clockwise(as you look at it—if you're viewing from the front, it appearsto be a clockwise
move2). Thebuttonmarked RScw meansto look at the right faceandturn thecenterslice90

2If youaremanipulatingaphysicalcube,aneasyway to keepclockwiseandcounter-clockwisestraightis to remem-
berthatto geta clockwisemove of a face,graspit with theright handandturn it in thedirectionpointedto by theright
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degreesclockwise.Finally, the UCcw meansto look directly at theUp faceandturn theentire
cube90 degreesclockwise. Rememberthat if the shift key is held down whenany of these
buttonsarepressed,the movementis in the oppositedirection. (If you arebefuddledby this
paragraph,just try clicking on thefaceswith variouscombinationsof shift, control andalt and
clicking on the buttonsin the control areawith andwithout the shift key and it will become
clear.)
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Figure2: CubeCoordinates

Note that there's no needfor counter-clockwise
slice or whole-cubemoves; BScw is the sameas
turningtheFrontslicecounter-clockwiseandsim-
ilarly for whole-cubemoves. You can also hold
down theshift key to getthereversemovement.

The cubeappearsto be madeof 27 smaller“cu-
bies”, of which you can see the 26 outer ones.
(Therereally is no centercubie, but that doesn't
matter.) Thereare threekinds of visible cubies:
corner cubies with three colors (there are eight
of these),edgecubieswith two colors (thereare
twelve of these)and face cubieswith one color
(therearesix of these).

A cubiecanbe identi�ed by the three,two or one
colors (or better, by the three, two or one faces.
The UFR cubie is the cornercubie in the upper-
front-right. The LD cubieis an edgecubeon the
left-down edge.TheR cubieis thecentercubieon
theright face.See�gure 2.

With thedefaultcubeasdisplayedin theprogram,theLUF cubeis theonewith thegreen,white
andred facesshowing. (It' s the only cornercubieall of whosefacesarevisible on the large
cube.)Thethreeedgecubiesnext to it arethewhite-red(UF), white-green(UL) andgreen-red
(LF) cubies.

If you arejust talking abouta particularcubiewhoseorientationis unimportant,thentheorder
of the lettersdoesnot matter: URF, UFR, RUF, RFU, FUR andFRU would refer to the same
cubie.If youwishto describeatransformationexactly it canbedoneby payingcarefulattention
to theorderof theletters.For example,atransformationthat�ips theUL andUF cubiesin place
(in otherwords,thecubesstayin thesamelocationson thecube,but thecolorsareexchanged)
mightbewritten like this:

(UL; UF ) ! (LU; F U) or (UL)(UF )

wherethenotationindicatesthatthecubiesstayin thesamelocations,but thefacesare�ipped.
The secondpossibility is in “cycle notation” whereeachelementin a pair of parenthesesis
assumedto moveto theelementto theright andtherightmostreturnsto the�rst element.Since
thereis only a single face,it' s clear that the notationrefersto a cubie that staysin placebut
changesorientation.

thumb.
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In thesameway, a transformationthatrotatesa pair of cornercubiesin placemightbewritten:

(UF L; UF R) ! (LU F; RUF ) or (UF L)(UF R).

Finally, a transformationthatcyclesthreeedgecubiesRF to UF, UF to FL andFL to RF might
bewritten:

(RF; UF; F L) ! (UF; F L; RF ) or simply (RF UL F L).

Youcan�nd thiscycle form of thepermutationthatwill takea solvedcubeto theonedisplayed
on your screenby usingthe DisplayPermutationcommandin the File pull-down menu.The
permutationis displayedin a window thatpopsup.

Thepermutationof thecubeis displayedin two forms. The�rst indicateshow thecubiesmove
onthecube.Thisis thewaymostpeoplethink aboutcubepermutations,but it cannotcompletely
representthesituation.We canindicatethehow a faceis rotatedor �ipped if it is in its original
location,or we canindicatehow theindividual cubiesmove into their slots,but not both. Here,
if thecubiesmove,thepermutationindicatesthecycling of thecubielocations.If a cubiestays
in oneplace,the permutationindicateshow the facesof that cubiearerotatedor �ipped. For
example,(RUF ) indicatesthat thecubieis in andremainsin theright-up-frontcorner, but that
the right facemovesto theup face,theup faceto the front face,andthe front facebackto the
right face.However, (RF UF F L) simply tells us that thosethreecubiescycle in themanner
shown, but it givesno indicationof whetherthey are�ipped or not.

To obtainacompletedescriptionof thepermutation,weneedto know whereeachof the54faces
move. Well, actuallyonly 48 of them,sincewe considerthecentercubieson eachfaceto stay
in place.Thesecondform of thepermutationdisplayedindicatesthis. Eachcornercubie(like
RUF ) hasthreefaces.For thatexample,Rubik usesRuf to indicatethefaceontheright, Ur f
for theup face,andF ur for thefront faceof thatsamecubie.Similarly for theedgecubies.

After eachof thetwo cycle notationslistedabove is anindicationof thecycle structure.In that
structure,a termlike 3(4) meansthereare3 cyclesof length4. Cyclesof length1 aregenerally
notlistedsincethey indicatethatanobjectstaysin place,but in thecaseof thecubiepermutation,
1-cyclesindicatethe numberof cubesthat stayin placebut are�ipped or rotated. For details
youcanalwayslook at thecubiefacecyclenotation.

4 Solving the Cubewith Macros

A “macro” is simply a seriesof twistsconsideredto bea singleoperation.If, for example,you
turn thefront facetwice by 90degreesandthentheleft facetwice by 90 degrees,thatwould be
a four-movemacro.This is notaparticularlyusefulmacro,but it will serveasa goodexample.

Try thisout: Pressthe ResetCubebuttonto initialize thecube,andthenclick twiceonthefront
centercubie(theredone)andthentwiceontheleft centercubie(thegreenone).Thecubelooks
abit jumbled,but it' s still quiteregular. (Theshortcutfor ResetCube is control-R.)

Now repeattheoperationagain(Front,Front,Left, Left) sothatnow you'vedone8 totalquarter-
turns.Thecubeis still mixedup,but it' snot thatmuchworse.Repeatthefour quarter-turnsone
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moretime(for twelve total turns)andthecubeis almostsolved.If youexaminethecube's front
andrearviews, you shouldbeableto seethat thereareonly four cubiesout of place. Now do
theentirefour-movemacrothreemoretimes(that's twelve moretotal twists),andif you didn't
makeany mistakes,thecubereturnsto its “solved” con�guration.Prettyneat,huh?

It' s a little inconvient to do four clicks eachtime you wantto applythis macro,solet's seehow
to do it moreeasily.

Thereis a macrolanguagethatdescribesthestepsin amacro,andit' s fairly straight-forward:

� B, F, U, D, L, R: 90cir c clockwisemoveof thecorrespondingface.

� b, f, u, d, l, r: 90� counter-clockwisemoveof thecorrespondingface.

� *B, *F, *U, *D, *L, *R: 90� clockwiseslicemove.

� > B, > F, > U, > D, > L, > R: 90� whole-cubemove.

To constructa macro,just cramtogethertheappropriatelettersin a string. Your “Front Front
Left Left” macrois just:

FFLL

Let's seehow to useit. First,click on ResetCube to initialize thecube.

Click on the empty CurrentMacro input box (if it' s not empty, simply selectall the text in it
andtypethedeletekey). Next, typein “FFLL” (without thequotationmarks,of course).If you
now pressthereturn key on your keyboard,themacrois applied,andyou canwatchthefaces
rotate.

Noticethat just above theright endof the CurrentMacro input box is anoutputareathat lists
thelengthin stepsof themacro.Thiscanbevaluableif youwantto �nd macrosthataccomplish
varioustasksin theminimumnumberof steps.

In fact, if you pressthereturn key again,themacrois repeated.Thus,clicking on thereturn
key six timeswill doexactly thesamething thatyour24 individualmovesdid previously.

If you are in a hurry, click on the Apply Macro button in the control area,andthe macrois
simply appliedto thecubiesandall you seeis the�nal result—youdon't needto wait for them
to turnfor you. Try that—withthesameFFLL in themacrowindow (from aresetcube)click the
Apply Macro button6 timesto seehow it works.Theshortcutfor Apply Macro is control-A.

Now let's seehow macroscanbeextremelyusefulfor solvinga cube.Resetthecube(with the
ResetCube button)if it is not already, andclick on the“Flip UF UL” entryin themenubutton
labeledDe�ned Macros.

Two thingshappen.First, whatever you hadin the CurrentMacro areais replacedby this 14-
stepmacro:

FRBLUlUbr�uLu

In addition,thecubeis modi�ed to representtheresultafterthese14 moveshave beenapplied.
As you cansee,this macromight beveryusefulfor a solution.Any time youhave two adjacent
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edgecubiesthatarein thecorrectspots,but �ipped to thewrongorientation,youcouldplacethe
cubeasshown on thescreenandapplythose14moveswith theresultthatyour two edgecubies
wouldbe�ipped in place.

Click onthe“Flip UF UL” choicebuttonagainandthemacrois appliedasecondtime,returning
thecubeto its initial con�guration.

Now click in the CurrentMacro areawhereyou previously typed in the FFLL andtype the
return key. This time the14 stepsareappliedoneat a time soyou canseewhathappensto the
cubeasyou stepthroughthemacro. Any time you want to watcha macrooccur, click in that
CurrentMacro areaandeitherenteryour own macrode�nition or useonethat's thereandthen
pressthereturn key to stepthroughit. If you hold down theshift key whenyou pressreturn,
the inverseof themacrowill be appliedto thecube. In otherwords,if you startwith a solved
cube,thenexecutea macro,thenhold down the shift key andpressthe return key again,the
cubewill bereturnedto a solvedstate.

The Apply Macro buttonis alsoinvertedif theshift key is down whenit is pressed.

Thereare a few other macrosstoredin that list by default. To try others,click down in the
De�ned Macros menuchoicebutton,dragthemouseto beabovetheoneyouwant,andrelease
themousebutton.Thatmacrowill beappliedaswell asenteredin the CurrentMacro area.

To getagoodideaof whateachdoes,initialize thecubewith the ResetCube buttonbeforeyou
try eachone.All areusefultoolsthatmight beusedto solveacube(realor virtual).

4.1 De�ning Your Own Macros

If you have founda usefulsetof movesthatyou would like to beableto reuse,type it into the
CurrentMacro area,testit to besureit doeswhatyouwant,andthenclick onthe De�ne Macro
entryin the Macros pull-down menu.A text entrywindow will comeup,allowing you to name
yourmacro,andwhenyou'venamedit, it will appearin thelist of macros.

As soonasyou de�ne a new macro,it is written into thepreferences�le so that from thenon,
whenyou startRubik , you will havethosemacrosautomaticallyde�ned for you.

To deletea macrofrom the list in De�ned Macros, click on the DeleteMacro entry in the
Macros pull-down menu. Then type in the nameof the macro(exactly as it is in the list,
including spaces),andthe macrowill be deleted,not only from the currentlist, but alsofrom
thepreferences�le if you wish. Noticethat thedefault namefor themacroto deleteis the last
oneyou used,so thequickestway to deletea particularmacrois to useit andthendeleteit. If
you don't wantto alter thecubeby applyingthemacro,simply applythemacroandthenapply
it againwith theshift key down. This will doandundothemacroactionfor noneteffect.

You candeleteany of themacros,andif theoneyou deleteis oneyou de�ned, Rubik will ask
you if youwantto deleteit from thepreferences�le aswell. Youcanalsodeletethemacrosthat
appearin Rubik by default,but they will reappearthenext time yourun theprogram.

In addition, the commandDeleteAll Macros getsrid of all the macrosin the choicebutton.
Thisdoesnotdeleteany of themacrosyoude�ned from thepreferences�le.

Rememberthat if you appliedyour FFLL macrothreetimes,it did somethingfairly simple—it
exchangedtwo setsof edgecubiesandleft everythingelsein place.Thismightactuallybeuseful
for cubesolution,andsoyoucouldcreateamacrothatdoesthetwelve turnsby typing in:
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FFLLFFLLFFLL

andde�ning a macro.But there'sasimplerway. Justtype:

3(FFLL)

A numberbeforeapairof parenthesessaysto repeatthestuff insidetheparenthesesthatnumber
of times.Again,hereit' sabit of overkill to useit, but try typing3(FFLL) into the CurrentMacro
area,testit, nameit, anduseit.

In fact,suchgroupingcanbe nested.Again, this is harderthandoing it in thestraightforward
manner, but thefollowing representsthesamemacro:

3(2(F)2(L))

Obviously, for morecomplex situations,thismaysave a lot of time.

Rememberthatyoucanuseupper-caselettersfor counter-clockwisemoves,andyoucaninclude
sliceandwhole-cubemovesin yourmacros.Here'sa valid macro(notuseful,but valid):

3(f> DRR*Uu3(RF)2(FU))rfr21(FRFuud)

If you typejunk like that into the CurrentMacro areaandpressthereturn key, it' ll giveyou a
“show”. In this case,themacroaboveresultsin 177individualmoves.Do youseewhy?

We noticedthat if you repeatthesequenceFFLL six timesfrom aninitialized cube,thecubeis
returnedto “solved”. Whatis interestingis thateverymacrohassimilarbehavior: if yourepeatit
enoughtimesfrom asolvedcube,thecubewill returnto solved.Theminimumnumberof times
requiredto returnto the“solved” con�guration is calledthe“order” of themacro.Theorderof
FFLL is thus6.

Rubik allowsyou to �nd theorderof any macro.Typethemacrointo the CurrentMacro input
areaandpressthe MacroOrder button.Theresultis displayedin awindow. Try enteringFFLL
in the CurrentMacro area,pressMacroOrder andseethattheresultis 6.

If you enterjust FL, theorderis 105—probablylarger thanyou thought.You caneasilyverify
that105 repetitionsof theFL macroreturnsto “solved” by resettingthecube,typing 105FLl)
into the CurrentMacro area,andthenpressingthe Apply Macro button. (It' s a little tougher
to verify that 105 is the minimumnumberof applicationsof the macrorequiredto return to
solved—you'll justhave to trustRubik .)

Beingableto �nd theorderof a macrois usefulfor solvingcubessinceif theorderof a macro
hasdivisors,goingonly half-wayor a third of theway througha macrooftenhasusefulresults.
For example,if you initialize thecubeandtry thecombinationFL� , it moves7 total cubies—
not too usefulfor solvinga cube.But if you type it into the CurrentMacro areaandpressthe
MacroOrder button,you'll seethat theorderis 6. If you now try themacro3(FL�) you'll see
thatit swapstwo pairsof cornercubies,andthatmightbeuseful.
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4.2 The Macro Gizmo

Sometimesyou would like to have a setof macrosall availableat thetouchof a button. Rubik
candisplaya macrowindow whereyou cande�ne up to 16 suchmacros.All themacrosin the
gizmomustbede�ned macros.

Thegizmoholdsup to 16macros.Youcanentermore,but only the�rst 16aredisplayed.

To entera macrointo thegizmo,usethe Add Macroto Gizmo entryin the Macros pull-down
window. Enterthenameof themacroyou would like to addin thewindow thatpopsup. The
default namein thatwindow is themacrocurrentlyvisible in the De�ned Macros choicearea.
As soonasyou'veaddeda macro,themacrogizmoappearswith thenew macronamelistedon
a button. Pressingthis button is thesameasclicking on thenamein the De�ned Macros area,
includingthefeaturethatif theshift key is down, theinverseof thatmacrois applied.

To deletea macrofrom the gizmo, use DeleteMacrofrom Gizmo in the Macros pull-down
menu.Thisdoesnotdeleteit from thesetof de�ned macros—onlyfrom thegizmo.

If you have closedthemacrogizmowindow, you canre-openit with the Show MacroGizmo
buttonin the View pull-downmenu.If therearenomacrosin thegizmo,it will notbedisplayed.

This gizmo is useful when you are running experimentswith a restrictedset of moves. For
example,supposeyou would like to seewhat positionscanbe achieved usingonly the three
slicemoves. Puteachonein a macroandenterexactly thosethreeinto thegizmo. Thenclick
only on the gizmo buttons. Hint: if you move the gizmo to sit on top of the control areaof
Rubik 'swindow, youwon't accidentallyuseany of thenormally-availablebuttonsby accident.

To clear the macrogizmo, usethe ClearMacroGizmo commandin the Macros pull-down
menu.

If (andonly if) themacroyou addto thegizmois onethat is in your preferences�le, a change
will be madeto your preferences�le so that it will be loadedinto the gizmo eachtime you
startup Rubik . If you deletethis macrofrom the macrogizmo, the preferences�le will be
changedsothatit is notautomaticallyloadedinto thegizmoonstartup.Youcantemporarilyadd
macrosto thegizmo from thedefault startupsetor from macro�les that you have loaded,but
thatinformationis lost thenext timeyoustartupRubik . If youreallywantoneof thosemacros
in the gizmo permanently, de�ne your own copy of it andput that in the gizmo. Remember
that if themacrostring in a �le that you loadbegins with thecharacter“$”, thenthe macrois
automaticallyloadedinto thegizmowhenthe�le is loaded.

4.3 SingmasterNotation

David Singmasterwasoneof the�rst peopleto publisha bookleton Rubik's cube,andheused
anotationthatis differentfrom thatusedin Rubik . If yousearchonthewebyouwill �nd many
interestingmacrosdescribedin this so-calledSingmasternotation,soRubik hastheability to
interpretit.

Singmaster'snotationis quitesimple. It consistsof a stringof space-separatedentriesthat look
like this: U, U', U2, R, R', R2, et cetera.TheSingmasterU is Rubik 's U, theU' is Rubik 's u
and�nally , U2 is Rubik 'sUU. Similarly for theother5 faces/letters.

To entera macroin Singmasternotation,simply surroundit with bracketswhenyou type or
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pasteit into the CurrentMacro area,asfollows:

[ U D R2 L' B F' U2 ]

As you type it into the CurrentMacro input area(or pasteit in with control-V key) nothing
happensuntil youtypereturn or click onthe Apply Macro button.At thatpoint theSingmaster
notationis translatedto theRubik notationandthecontentsof theinput areaarechangedto be
in Rubik format,at whichpointyoucandoanythingyou likewith them.

To copy text from the CurrentMacro area,selectit andtypecontrol-C. To cut it, typecontrol-
X.

5 RecordingMacros

If youpressthe RecordOn buttonin thecontrolarea,Rubik will recordyourcubemovements
in the CurrentMacro input area.It usesexactly thesamesyntaxto recordthemoves,andonce
thetext is in thatinputarea,it canbeusedlikeany othermacro.

Doing almostanything otherthanmakingmovementswill get you out of this recordingmode
(but will leave themacroin the CurrentMacro input area).If you want to forceRubik out of
recordingmode,click on thesamebutton(whosenamehaschangedto RecordOff ).

The Undo command(in the Edit pull-downmenu)will erasethelastentryin theMacrowindow
aswell asundoingtheoperation.

6 Macrosfr om a File

If youwouldliketo usedifferentsetsof macrosfor differentrunsof theRubik program(perhaps
you arewriting a tutorial thatusestheprogram,for example),you cando so. Createa text �le
with pairsof lines that contain�rst the name,thenthe macroitself. For example,sucha �le
might look like this:

Three face twist
rld
Junk-filled macro
fuD>R*Duud*U*R*U
Striped Cube
[ D' F D' L B D2 F2 U R B' U R2 F D' R F U2 ]

This examplewould de�ne a macrocalled “Three facetwist” to be RLD andanothermacro
called“Junk-�lled macro” to be fuD> R*Duud*U*R*U. Finally, a third macrocalled“Striped
Cube”is de�ned in Singmasternotation.Supposethis �le is calledrubikmacs.rub .

If the macrostring begins with the character“$”, that macrowill alsobe addedto the macro
gizmo.SeeSection4.2

To put themacrosfrom a �le into the De�ned Macros area,usethe LoadMacroFile entry in
the File pull-down menu.A �le browserwill appearthatyou canuseto navigateto theproper
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directoryandselectthe�le rubikmacs.rub . Themacrosabovewill beaddedto your list of
de�ned macrosfor thecurrentsessiononly. Thesemacrosarenot storedin thepreferences�le,
so they will disappearthe next time you run Rubik andwill have to be reloadedagainif you
wantto usethemagain.

CurrentlyRubik doesnocheckingto makesurethatthenamesof macrosaredistinct. It' sup to
you to keepthemorganized.If you accidentallygeta duplicatename,you canalwaysdeleteit,
althoughit' snot clearwhichonewill bedeleted.

Includedwith thereleaseis a �le calledpatterns.rub thatcontainsanumberof macrosthat
produceprettypatternsif they areappliedto aninitializedcube.Givesomeof thema try.

If you've got somemacrosthat you developedwithin Rubik andwould like to save them,the
commandDumpMacroFile in the File pull-down menuallowsyou to specifya �le nameand
all of thecurrently-de�nedmacrosaredumpedthere.You'll haveto sortout themesswith atext
editor, assumingyouonly wanta few of them.

7 DemoMode

Makesurethatthe CurrentMacro areais emptyandpressthe StartDemo button.You'll getan
interestingdisplay. To stopthedemo,click on thesamebutton(whosenamehasbeenchanged
to StopDemo). If you �nd the“orbiting” smallrear-view of thecubeannoying, youcantoggle
it onandoff with the Show RearCube entryin the View pull-down menu.

If the CurrentMacro areais empty, demomodecreatesarandommacroandrepeatsit endlessly,
so it' s guaranteedto comebackto “solved” againandagain. Themacroit pickswill returnto
solvedin a reasonablenumberof turns(fewer than300).

If the CurrentMacro areais not emptywhenyou pressthe StartDemo button, the program
initializesthecubeandendlesslyappliesthemacroenteredthere.Thusif you �nd a macrothat
goesthoughpleasingstates,youcanprobablymakeanicerdemothanwhattheprogramis likely
to comeup with by itself (but sometimesRubik will surpriseyou). You might try demomode
with someof themacrosin the�le patternmacs.rub .

If Rubik makesup a macrofor usein demomode,it putsit in the CurrentMacro displayarea
soin caseit stumblesacrossa goodone,youcansave it.

8 Jumbling and �nding Rubik 'sSolution

If you wantto practicesolvingjumbledcubes,simply pressthe Jumblebuttonandyou'll geta
completelyjumbledcubethatyoucantry to solvewith acombinationof edgemovesandmacros.
(If you pry apartyour cubewith a screwdriver, mix thepieces,andassembleit with your eyes
closed,you haveonechancein twelveof obtainingasolvablecube.)

Of courseit' s pretty easyfor you to mix up the virtual cubehopelesslyyourself with a few
randomclicks on thebuttonsin thecontrolarea.

If youwanttheprogramto solveacubefor you,Simplyclick onthe SolveCubebutton. It may
take a while. The�rst time you do this, thereis alsoan initialization thatoccursthatalsotakes
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time. (On my dualprocessor1.25GHz Power Mac, it takesperhaps�fteen secondsto �nd the
solutionfor an“average”cube(includinginitialization). Onmy old 400MHz PC,it takesabout
60seconds.)

Thesolutionappearsin the CurrentMacro area.You caneithermake thosemovesyourselfor
click in the CurrentMacro areaandpressthereturn key to watchtheprogramsolve thecube.
Don't simply click on the Apply Macro button—thatwould just be theequivalentof pressing
the ResetCube button,right?

By theway, youcanconvinceyourselfthatRubik really is solvingthecubeandnot just watch-
ing theturnsyoumakeasyoujumbleit andreversingthose.Try startingwith aninitializedcube,
make about50 moves,andthenclick on SolveCube. It will certainly�nd a solutionthathas
fewer than50quarter-twists(Rubik 's solutionis typically between25and30moves).

Whenyou pressthe SolveCube button,Rubik spendsa “reasonable”amountof time looking
for agoodsolution.If you'd liketo haveit spendmoretimeandmakeit look for abettersolution,
therearetwo entriesin the Edit pull-down menu: LongSolve and VeryLongSolve. If these
aretoggledon,Rubik will spendmoretimeandmuch moretimesearchingfor a solution.Even
if Rubik is in oneof thesemodes,a solutionmaynot take longer—if Rubik is convincedthat
it hasthebestsolution,thesearchcanendearly. You canconvinceyourselfthat this is trueby
making,say, threequarter-turnsonasolvedcubeandthenclicking on the SolveCubebuttonin
VeryLongSolve mode.

9 Solving a Physical Cube

If yourplasticcubeis jumbledandyou're too stupidto solve it yourselfandtoo lazy to take out
thescrewdriverto breakit apartandthenreassembleit, here'sawayto solveit withoutwracking
yourbraintoomuch.

Enter your cube's con�guration into the programand usethe SolveCube facility described
above. When you seethe macro in the window, manuallyapply that to your own cubeby
physicallyturningthesides,andthereyou are!Besurethatyourcubeis in thesameorientation
asthe cubeon the screenbeforeyou begin to apply the movesor you'll wind up with a cube
that'ssimply jumbledin a differentway.

To make sureyou arefollowing themacroexactly on your physicalcube,especiallywhenyou
are a beginner, you can usethe left-arr ow and right-arr ow keys to single-stepforward and
backward throughthe macro. Thus,the safestway to solve your cubeis to make oneor two
physicalmoves,thensingle-stepthemacrothesamenumberof stepsandcomparetheresults.If
they aredifferent,youareat mosta coupleof movesaway from thepathto thecorrectsolution.
Rememberthatyoucanbackupon thescreenaswell with theleft-arr ow key.

You can�nd thenumberof stepsin thesolutionby looking at the “Macro length” outputarea
abovethe CurrentMacro inputarea.If themacrodoesn't makesense(or is incompletebecause
youhaven't �nished typing it in), then“*****” will bedisplayedasits length.

Remember, however, that onescrew-up in the middle will totally trasheverythingandyou'll
haveto startagain.

All youneedto know now is how to enteryourcube'scolor con�gurationinto theprogram.
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For now, I will assumeyour cubehasthe samecolors as thosein the default cube(which,
surprisingly, arethesameasthoseonmy personalphysicalcube).

But here'show it workswith my cube(which is prettystandard,I think).

My cube's colors are Orange,Red, Green,Blue, White and Yellow. The �rst lettersare all
distinct,soI' ll call themO, R, G, B, W andY.

If the red centercubie is facingme andthe white centercubie is up, then“Back” is orange,
“Right” is blue,“Left” is green,and“Down” is yellow. If thecubeweremadeof justacardboard
shell, andpaintedasin the “solved” con�guration, you could cut it alongvariousof its edges
andunwrapit to look like this:

W
G R B O

Y
(The �gure above representsa con�guration wherethe white faceis on top, the red is facing
you, the yellow is facing down, the greenfaceis to the left, et cetera,just as in the default
con�gurationonRubik 'sdisplay.)

Now, Imaginethat you againcut the cubeasabove, but this time draw out eachfacewith the
nine colorsthat make it up. Whenyou do that, eachof the lettersin the patternabove would
really represent9 colors.

To enteryour cube,click on the InputCube button anda window like that shown in �gure 3
will appear.

Figure3: SetCubeGizmo
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Oneof the entriesis highlighted(whenyou begin, it' s the onein the upper-left cornerof the
“Up” face).At thebottomof thewindow is a setof color buttons.If you click on oneof those,
thecolorof theselectedcubiefacechangesto bethatcolorandtheselectedcubiefaceadvances
one.If you justwantto changeafew colors,youcanclick onacubiefaceto makeit theselected
one,andcontinuefrom there.In addition,you cantypethespaceandbackspacekeys to move
theselectedcubieforwardor backwithout changingthecolors.Whenyouaresatis�edwith the
cubecoloring,click on the Finish button.

Makesureespeciallynot to screw up theback—whenit' s “unwrapped”it goesthe“otherway”.
If you have any doubtsabouthow this works, thecubedisplayedin �gure 1 is thesameasthe
onedisplayedunwrappedin �gure 3.

Whenyou �nish settingcolors,Rubik doesa “sanity check”on thecubecolorsto make sure
youhavetheright numberof cubiescoloredin away thatthecubecanbesolved.If youdonot,
Rubik displaysanerrordialogandreturnsyou to the input gizmo. If you just can't �gure out
how to �x your cube,pressthe Resetbutton in thegizmoandthecubewill revert to a solved
state.

If thecubein theinputgizmois invalid for somereason,thatreasonwill bepresentedin thetext
outputareain the lower-left partof thewindow. Rubik will list in thatwindow onething that
is wrong. Theremaybe many problems,but asyou �x each,thenext appearsin thatwindow.
Whenit is completelyvalid, thetext in thatwindow will be“Valid Cube”.

Thegizmoalsocontainsa Flip/Rotatebutton.If youpressthis,thecurrently-selectedcubiewill
�ip (if it' s anedge)or rotate(if it' s acorner).Rotationis alwaysin thesamedirection,soif you
wantto rotatein theoppositedirection,justclick on thebuttontwice.

10 SettingCube Colors

If yourcube'scolorsdon't matchthedefaultcolors,youcanchangethedefaultcolor settings.

Herearethecolorscurrentlyrecognizedby Rubik , andtheirone-letterabbreviations(whichcan
bein lower-caseaswell):

R: red W: white B: blue Y: yellow G: green
O: orange S: silver K: black V: violet P: pink
D: gold M: magenta X: gray C: cyan

To specifyacoloring,list theletterscorrespondingto yourcube'scolorsin thefollowing order:

Up Left FrontRightBackDown

Thedefautcolorsarethus:WGRBOY. If your cubeis redon top,white on thebottom,blackin
front, pink in the rear, magentaon the left andgold on the right, your color patternwould be:
RMKDPX. Thesearethelettersandcolorsthatwill bedisplayedonthescreenandonthegizmo
thatletsyouentercubecon�gurations.

To changethesedefault colors,pressthe SetCubeColors entry in the View pull-down menu.
Thenenteryour six-characterstringin theinput window thatappears.Fromthenon, (until you
setthecolorsagainin thesameway)Rubik will usethatcolorscheme.Whenyousetthecolors,
theresultis alsowritten into thepreferences�le.
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11 Printing the Curr ent Cube

In the File pull-down menuis anentry: PrintEPSFile . This will causeRubik to producean
encapsulatedPostScript�le thatdisplaysthecurrentfront faceof thecube.You canusethis in
any wayyou want.

12 Button Reference

Whatfollows is a shortdescriptionof theactionsof eachof thecommandbuttonsin thecontrol
areaandmenuentriesin the pull-down menu. Onehopesthat the actionsof the face-turning
buttonsareobvious.Thebuttonsarelistedin alphabeticalorder.

Add Macroto Gizmo addsa previouslyde�ned macroto themacrogizmo.

Apply Macro appliesthecontentsof the CurrentMacro input areato thecubeinstantly, without letting
you seetheindividualmoves.

ClearMacroGizmo emptiesthemacrogizmo.

De�ne Macro letsyou assigna nameto thecontentsof the CurrentMacro areaandthe(name,macro)
pair is placedin the De�ned Macros menubutton.

DeleteAll Macros deletesall themacrosin the De�ned Macros list. It doesnotdeleteany macrosfrom your
preferences�le.

DeleteMacro deletesa macroin the De�ned Macros list. If thatmacrois in your preferences�le, you
will beaskedif youwantto deleteit from thereaswell.

DeleteMacrofrom Gizmo deletesamacrofrom themacrogizmo.Thishasnoeffectonthecurrentlyde�nedmacros.

DisplayPermutation displaysin cycle format the permutationrequiredto bring a solved cubeto the current
con�guration.

DumpMacroFile writes the macrode�nitions in a form that Rubik can read into a �le whosenameis
speci�edby theuser.

Help is currentlyapitiful place-holderfor somethingbetterin a futurerelease.

InputCube allowsyou to enteryourcube'scolorsinto theprogramfor testmanipulationor solution.

JumbleCube createsasolvablejumbledcube.

LoadMacroFile loadsa setof macrosfrom a �le.

LongSolve increasesthe amountof time that Rubik will spendlooking for a goodsolution. This
buttoncanbetoggledonandoff.

MacroOrder determinestheorderof themacroin the CurrentMacro area.
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PrintEPSFile producesandencapsulatedPostScript�le of thefront faceof thecurrentcubecon�gura-
tion.

RecordOn startsrecordingmovementsin the CurrentMacro input area.Whenin recordingmode,
this key changesto be RecordOff .

ResetCube initializesthecubeto “solved” andemptiestheundobuffer.

SetCubeSpeed setsthe speedat which the facesturn. Smallernumbersrepresentfasterturning. The
numberyou type in is thenumberof stepsduringa turn. If your graphicsis prettygood
(asof 2003)a speedof about80 is good. On ancientmachinesor badgraphics,a 10 or
even 5 might be the way to go. Whenyou setthe speed,the new valueis storedin the
preferences�le. Setthespeedto whateverpleasesyou.

SetCubeColors setsthedefaultcolorson thefacesof a solvedcube.

Show MacroGizmo displaysthemacrogizmowindow.

Show RearCube togglesonandoff therearcubeview.

SolveCube solvesthecurrentcubecon�guration. A macrorepresentingthesolutionis thenentered
into the CurrentMacro area.You cantypereturn to watchit solve automaticallyor you
cansingle-stepit with theright-arr ow key, which is probablythebestapproachif you're
usingRubik to solvea physicalcube.

StartDemo entersdemomode.On entry, thebuttonchangesto StopDemo.

Quit quitstheprogram.

Undo undoesonequarter-twist.

VeryLongSolve dramaticallyincreasestheamountof time thatRubik will spendlooking for agoodsolu-
tion. Thisbuttoncanbetoggledonandoff.
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